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ABSTRAK 

 

Program ini bertujuan untuk: 1) meningkatkan kemampuan memanfaatkan 

aplikasi TIK dalam pembelajaran PKn bagi guru-guru Pendidikan 

Kewarganegaraan SMP se-Kabupaten Sleman D.I. Yogyakarta, 2) meningkatkan 

kemampuan memanfaatkan Hot Potatoes dalam pengembangan instrumen 

evaluasi pembelajaran Pendidikan Kewarganegaraan bagi guru-guru Pendidikan 

Kewarganegaraan SMP se-Kabupaten Sleman D.I. Yogyakarta 

Kegiatan dilaksanakan dalam bentuk skimming dan scanning konseptual, 

praktek, dan pendampingan. Skimming dan scanning konseptual digunakan untuk 

secara sekilas mengelaborasi prinsip-prinsip pemanfaatan ICT, e-learning, dan 

Hot Potatoes. Praktek diterapkan pada pengembangan instrumen evaluasi berbasis 

Hot Potatoes secara langsung oleh peserta, sedangkan pendampingan dilakukan 

oleh instruktur dalam proses pengembangan instrumen evaluasi menggunakan 

oleh peserta pelatihan/guru. 

Program ini menunjukkan hasil berikut: Secara kuantitatif, hasil 

pelaksanaan kegiatan ini dapat dilihat secara tangible selama atau setelah 

kegiatan, mulai dari peserta hingga materi kegiatan. Kegiatan PPM ini diikuti oleh 

25 orang peserta atau sekitar 80% dari target 30 peserta. 25 orang peserta tersebut 

adalah guru dari berbagai daerah di Kabupaten Sleman DI Yogyakarta. Secara 

kualitatif hasil pelatihan dapat dinilai dari pencapaian hasil-hasil yang bersifat 

intangible. Antara lain pertambahan pengetahuan dan sikap positif mengenai TIK, 

khususnya pengembangan e-learning berbasis blog. Meningkatnya pengetahuan 

dapat diabstraksi secara sederhana dari interaksi yang terjadi selama pelatihan 

berlangsung. Di sisi ketrampilan, pelatihan ini telah meningkatkan kemampuan 

para guru peserta PPM ini dimana sebagian besar nereka mampu mengembangkan 

instrumen menggunakan Hot Potatoes. Sedangkan sikap positif atas TI, khususnya 

pengembangan Hot Potatoes, dapat dicermati dari antusiasme para guru dan 

kegigihan yang mereka tampilkan selama proses pelatihan berlangsung. Dalam 

pengamatan Tim penyelenggara antusiasme peserta cukup baik. Partisipasi peserta 

dalam menerima materi pelatihan juga bagus, misalnya dengan bertanya atau 

meminta pendampingan jika mengalami kesulitan. 

 

Kata kunci: Hot Potatoes, ICT, pembelajaran PKn 

 

 

 

 

 

 

 

 

 

 

 

 



iv 

 

KATA PENGANTAR 

 

Puji syukur hanyalah untuk ALLAH, Tuhan Maha Penyayang, seru 

sekalian alam. Anugerah-Nya begitu agung, berupa hidayah, berkah dan rahmah 

tercurah selama penelitian ini, serta hikmah untuk mengasah dan meningkatkan 

kesabaran.  

Atas terselesaikannya Laporan ini, saya mengucapkan terima kasih yang 

sebesar-besarnya kepada : 

1. Dekan Fakultas Ilmu Sosial  Universitas Negeri Yogyakarta, atas 

bantuan penyediaan dana PPM ini. 

2. Seluruh Bapak dan Ibu Dosen yang telah memberikan sumbang saran 

terutama saat seminar proposal dan seminar hasil PPM ini. 

3. Para fasilitator dan peserta yang telah berpartisipasi dalam pelaksanaan 

PPM ini. 

4. Semua pihak yang tidak mungkin disebutkan satu per satu atas 

kontribusinya pada program ini.  

 

Semoga program pengabdian ini bermanfaat bagi masyarakat, khususnya 

guru-guru, juga bangsa dan negara. 

 

Yogyakarta, 30 Oktober 2015 

 
 



1 

 

BAB I 

PENDAHULUAN 

  

A. Analisis Situasi 

Kualitas guru sampai saat ini merupakan isu pendidikan yang terus 

mendapatkan sorotan. Kualitas guru memiliki hubungan yang signifikan 

dengan kualitas pembelajaran. Sebagaimana dimafhumi, salah satu aksioma 

dalam pendidikan adalah bahwa guru yang baik akan melaksanakan 

pembelajaran dengan baik.  

Upaya untuk menciptakan pembelajaran yang efektif dan 

menyenangkan (joyful learning) dapat dilakukan dengan mengoptimalkan 

pemanfaatan teknologi informasi dan komunikasi (TIK/ICT).  

Perkembangan kecanggihan merupakan bagian tak terelakkan dari 

modernisasi. Era modern ditandai dengan mobilitas dan dinamika masyarakat 

yang sangat tinggi. Akselerasi berbagai aktivitas manusia merupakan side 

effect yang tak terhindarkan. Dalam situasi demikian pemanfaatan dimensi 

ruang dan waktu begitu sangat berharga dan menentukan kualitas aktivitas 

manusia. Di sisi lain, perkembangan teknologi informasi dan komunikasi 

memungkinkan pemanfaatan dimensi ruang dan waktu tersebut secara lebih 

optimal. 

Seiring dengan perkembangan teknologi informasi dan komunikasi 

yang semakin pesat, dunia pendidikan harus mengadaptasi kemajuan tersebut 

dan memanfaatkan aspek-aspeknya untuk pemajuan bidang pendidikan, 

khususnya untuk meningkatkan efektivitas dan fleksibilitas pembelajaran, 
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apalagi kemajuan TIK sebenarnya merupakan bagian dari perkembangan 

IPTEKS yang sebagian besar prosesnya berkembang di dalam lembaga-

lembaga pendidikan. Thus, kebutuhan akan konsep atau mekanisme 

pendidikan (misalnya pada aspek manajemen konten pembelajaran) berbasis 

ICT menjadi keharusan. Itu lah yang kini kita sebut sebagai e-learning, yang 

memungkinkan terjadinya proses transformasi pendidikan konvensional ke 

dalam bentuk digital, baik dalam aspek isi (contents) maupun sistem 

pembelarannya.  

Oleh karena itu, pemanfaatan ICT dalam dunia pendidikan di Indonesia 

mewujud sebagai tuntutan mendesak. Hal ini merupakan kebutuhan 

mengingat perkembangan ilmu pengetahuan beririsan dengan kemajuan ICT. 

Kemampuan kompetitif dan komparatif SDM Indonesia ditentukan salah 

satunya oleh tingkat akses mereka terhadap ICT. 

Persoalannya, banyak guru yang belum memiliki kemampuan 

memanfaatkan ICT untuk mengembangkan pembelajaran yang efektif dan 

sekaligus menyenangkan. Padahal begitu banyak aplikasi yang bisa 

dimanfaatkan untuk itu. Salah satunya aplikasi dalam pengembangan evaluasi 

pembelajaran. Aplikasi yang relatif sering digunakan di “luar” adalah hot 

potatoes.  

Namun, guru-guru dalam dunia persekolahan, termasuk di Jogja yang 

nota bene Kota Pendidikan, belum cukup familiar dengan aplikasi ini. Oleh 

karena itu dibutuhkan pelatihan bagi para guru untuk mengembangkan 
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instrumen evaluasi dengan memanfaatkan Hot Potatoes. Untuk urgensi dan 

relevansi itulah PPM ini akan dilaksanakan.  

  

B. Tinjauan Pustaka 

Pada masa-masa yang lalu kegiatan belajar lebih banyak diasumsikan 

sebagai proses yang harus berlangsung dalam sebuah ruang kelas. Dalam 

ruang tersebut, guru atau dosen mengajar di depan kelas sambil sesekali 

menulis materi pelajaran di papan tulis. Di samping itu, sebenarnya juga 

dikenal istilah yang disebut pembelajaran jarak jauh atau pendidikan jarak 

jauh. Tapi, terminologi yang disebut terakhir ini masih sangat sederhana dan 

belum seperti yang terjadi saat ini seiring dengan berkembangpesatnya 

teknologi informasi dan komunikasi. 

Perkembangan TIK saat ini sangat memungkinkan untuk dilakukannya 

pembelajaran jarak jauh yang difasilitasi perangkat digital, baik dalam bentuk 

hardware maupun software. Pembelajaran sejatinya tidak harus 

memanfaatkan ruangan, baik kelas maupun laboratorium, dan tidak 

meniscayakan pertemuan secara langsung. Dalam pada itu, pembelajaran 

dengan metode tersebut dapat membantu orang-orang yang membutuhkan 

proses pembelajaran atau ingin mengenyam dunia pendidikan tanpa harus 

terhalangi oleh persoalan-persoalan geografis. Rancangan pembelajaran jarak 

jauh kini  sudah sangat fisibel dengan memanfaatkan internet dan perangkat 

teknologi informasi lainnya. 
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Namun, pemanfaatan TIK dalam pembelajaran tidak selalu untuk 

”memindah pembelajaran dari berbatas kelas ke tak berbatas ruang kelas”, 

akan tetapi dapat juga difokuskan untuk mewujudkan fleksibilitas (Panen, 

2005: 1-5, Basori, 2007: 1). Dengan demikian pembelajaran dapat tetap 

berlangsung di kelas yang dikombinasikan dengan pembelajaran ”tanpa 

kelas”. Pilihan atas keduanya disesuaikan dengan tujuan pembelajaran dan 

karakteristik materi yang akan diajarkan. 

Tentang kondisi pembelajaran dan fasilitas apa yang sesuai, dapat 

dilihat pada tabel berikut ini:  

 Waktu sama 

(Sinkron) 

Waktu Berbeda 

(Tidak Sinkron) 

Tempat sama Ruang kelas Pusat belajar 

Laboratorium 

Perpustakaan 

Tempat 

berbeda 

Audio-conference  

Videoconference  

Pesan satelit  

Ruang chatting 

Instrutor-led  

Synchronous Learning 

Systems 

Synchronous Streaming  

Learning Management 

Systems  

Video tape/audio tape  

CD-ROM  

Archived Streamed  

Video  

Email/milis 

 

Tabel 1. Diadaptasi dari Distance Learning and Sun Microsystems (2007), 

dikutip dari link http://dl2.cs.ui.ac.id/harrybs/e-Learning.pdf (doakses pada 

tanggal 13 Desember 2007) 

 

Kondisi Pertama, yaitu belajar di waktu dan tempat yang sama. Belajar 

model seperti ini tak lain adalah belajar di ruang kelas. Kondisi Kedua, yaitu 

belajar di waktu yang berbeda, tetapi di tempat yang sama. Untuk belajar 

http://dl2.cs.ui.ac.id/harrybs/e-Learning.pdf
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model seperti ini kita memerlukan Learning Center, Laboratory, serta 

Library. 

Kondisi Ketiga, yaitu belajar di waktu yang sama, tetapi di tempat yang 

berbeda. Untuk belajar model seperti ini kita memerlukan 

Audioconferencing, Videoconferencing, Satellite delivery, Chat Room, 

Instrutor-led (Synchronous Learning Systems), Synchronous Streaming. 

Kondisi Keempat, yaitu belajar di waktu dan tempat yang berbeda. Untuk 

belajar model seperti ini, kita memerlukan infrastruktur Internet, Learning 

Management System (LMS), serta materi e-Learning yang pedagogical 

soundness. 

Pembelajaran memanfaatkan kecanggihan TIK belakangan kemudian 

dikenal dengan istilah electronic learning atau  disingkat e-learning. 

Pembelajaran jarak jauh modern ini memanfatkan pada pokoknya fasilitas 

internet. Disebut pembelajaran jarak jauh modern karena sebenarnya dikenal 

istilah pembelajaran jarak jauh, jauh sebelum apa yang sekarang ini 

berkembang.  

Dalam khazanah pedidikan, terdapat beberapa istilah yang mirip dengan 

e-learning, seperti: Distance Education, Distance Learning, Computer 

Mediated Learning, Computer Aided Instruction, dsb. Sehingga sangat 

dimungkinkan peluang overlapping dalam penggunaan istilah-istilah yang 

tersebut. E-learning saat ini mewujud sebagai terminologi yang sangat akrab 

digunakan. 
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Untuk menemukan perbandingan dari beberapa istilah yang mirip, 

dapat dikemukan definisi Ornager, Webopedia, dan Jenkins and Hanson 

sebagaimana dikutip oleh Harry B. Santoso (2007: 2) sebagai berikut:  

1. Distance Learning, adalah pelaksanaan kegiatan instruksional yang 

tidak mengharuskan siswa untuk hadir secara fisik pada tempat yang 

sama dengan pengajar.  

2. Distance Education, yaitu model pembelajaran dimana siswa berada di 

rumah atau kantor mereka dan berkomunikasi dengan dosen maupun 

dengan sesama mahasiswa melalui e-mail, forum diskusi elektronik, 

videoconference, serta bentuk komunikasi lain yang berbasis 

komputer.  

3. E-Learning, merupakan proses belajar yang difasilitasi dan didukung 

dengan pemanfaatan teknologi informasi dan komunikasi.  

Menurut Allan J. Henderson (2004), e-learning adalah pembelajaran 

jarak jauh yang menggunakan teknologi komputer, atau biasanya Internet. 

Henderson menambahkan juga bahwa e-learning memungkinkan pembelajar 

untuk belajar melalui komputer di tempat mereka masing-masing tanpa harus 

secara fisik pergi mengikuti pelajaran di kelas. William Horton (2004: 2) 

menjelaskan bahwa e-learning merupakan pembelajaran berbasis web (yang 

bisa diakses dari Internet). E-learning memungkinkan pembelajar untuk 

menimba ilmu tanpa harus secara fisik menghadiri kelas. 

Dalam bahasa yang lain Paulina Panen (2005: 2) menyatakan bahwa 

e-learning merupakan seperangkat paket informasi untuk pembelajaran  yang 
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tersedia setiap saat melalui sistem penyampaian elektronik, dalam bentuk 

web-based learning, computer-based learning, virtual classroom, atau digital 

collaboration. Paket informasi tersebut terdiri dari berbagai objek dan unit, 

termasuk tes dan alat uji yang memungkinkan seseorang melakukan ujian atas 

kemampuannya setiap saat. Paket informasi tersebut dapat berbentuk beragam 

media–tekstual (teks), visual (video, satellite broadcast), audio, 

gambar/ilustrasi, dan lain-lain. 

Berdasarkan aspek interaktivitasnya, beberapa sistem e-learning yang 

dikembangkan dapat dibagi menjadi 2 (dua) kelompok:  

Pertama, sistem yang bersifat statis. Dalam sistem ini, pengguna atau 

subjek belajar hanya dapat men-download bahan-bahan belajar yang 

diperlukan. Sedangkan tenaga pendidik atau administrator hanya dapat meng-

upload file-file materi. Pada sistem ini memang suasana belajar yang 

sebenarnya tak dapat dihadirkan, misalnya jalinan komunikasi di antara para 

peserta didik atau antara pesera didik dengan pengajar. Sistem ini cukup 

berguna bagi mereka yang mampu belajar otodidak dari sumber-sumber 

bacaan yang disediakan dalam sistem ini, baik yang berformat HTML, 

PowerPoint, PDF, maupun yang berupa video. E-learning dalam kelompok 

ini dapat digunakan untuk mendukung pembelajaran langsung melalui tatap 

muka di kelas. 

Kedua, sistem yang bersifat dinamis. Fasilitas yang ada pada sistem 

ini lebih bervariasi dari apa yang ditawarkan sistem pertama. Pada sistem 

kedua ini, fasilitas seperti forum diskusi, chat, e-mail, alat bantu evaluasi 
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pembelajaran, manajemen pengguna, serta manajemen materi elektronis 

sudah tersedia. Sehingga pengguna mampu belajar dalam lingkungan belajar 

yang tidak jauh berbeda dengan suasana kelas. Sistem kedua ini dapat 

digunakan untuk membantu proses transformasi paradigma pembelajaran dari 

teacher-centered menuju student-centered. Bukan lagi pengajar yang aktif 

memberikan materi atau meminta mahasiswa bertanya mengenai sesuatu 

yang belum dipahami, tetapi disini mahasiswa dilatih untuk belajar secara 

kritis dan aktif. Sistem e-Learning yang dikembangkan dapat menggunakan 

pendekatan metode belajar kolaboratif (collaborative learning) maupun 

belajar dari proses memecahkan problem yang disodorkan (problem-based 

learning). 

E-learning secara ideal dan faktual meliputi seluruh tahapan 

pembelajaran, dari perencanaan hingga evaluasi. Seiring dengan semakin 

berkembangnya dunia digital dan teknologi informasi dan komunikasi, sudah 

banyak dikembangkan aplikasi untuk masing-masing tahapan. 

  

C. Identifikasi Dan Perumusan Masalah 

1. Pembelajaran yang menyenangkan merupakan keniscayaan untuk 

menciptakan pembelajaran yang efektif, namun sebagian besar guru tidak 

memiliki pengetahuan dan kemampuan untuk itu.   

2. Pemanfaatan perkembangan TIK/ICT merupakan salah satu upaya untuk 

menciptakan pembelajaran yang efektif dan menyenangkan, namun tidak 

banyak guru yang melakukannya. 
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3. Diperlukan peningkatan kemampuan memanfaatkan TIK/ICT untuk 

pembelajaran melalui Pelatihan pengembangan instrumen evaluasi 

pembelajaran berbasis pemanfaatan Hot Potatoes. 

 

D. Tujuan Kegiatan 

1. Meningkatkan kemampuan memanfaatkan aplikasi TIK dalam 

pembelajaran PKn bagi guru-guru Pendidikan Kewarganegaraan SMP se-

Kabupaten Sleman D.I. Yogyakarta 

2. Meningkatkan kemampuan memanfaatkan Hot Potatoes dalam 

pengembangan instrumen evaluasi pembelajaran Pendidikan 

Kewarganegaraan bagi guru-guru Pendidikan Kewarganegaraan SMP se-

Kabupaten Sleman D.I. Yogyakarta 

 

E. Manfaat Kegiatan 

1. Pelatihan akan memberikan bekal kemampuan bagi guru-guru PKn SMP 

di Kabupaten Sleman DIY dalam mengembangkan pembelajaran yang 

menyenangkan melalui pemanfaatan aplikasi TIK. 

2. Program ini akan memberikan bekal kemampuan bagi guru-guru PKn 

SMP di Kabupaten Sleman DIY untuk mengembangkan instrumen 

evaluasi pembelajaran dengan memanfaatkan aplikasi Hot Potatoes. 

 

F. Kerangka Pemecahan Masalah 
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Rendahnya kemampuan memanfaatkan internet dalam pembelajaran 

merupakan kendala/masalah serius di kalangan guru pada zaman dimana 

teknologi ICT sudah berkembang sedemikian pesatnya. Untuk mengatasi 

permasalahan tersebut, pelatihan akan dilakukan bagi guru-guru Pendidikan 

Kewarganegaraan SMP di Kabupaten Sleman. Pelatihan tersebut dilakukan 

dengan kerangka input-proses-out put sebagaimana terlampir. 

.  

 

 

BAB II 

METODE PELAKSANAAN KEGIATAN 

 

A. Khalayak Sasaran Strategis 

Khalayak sasaran (target groups) yang akan dituju dalam pelatihan ini 

adalah 35 orang guru mata pelajaran Pendidikan Kewarganegaraan SMP yang 

tersebar di beberapa wilayah di Kabupaten Kabupaten Sleman. Mengapa guru 

mata pelajaran PKn? Diasumsikan, mata pelajaran PKn merupakan mata 

pelajaran dengan konten teoretik yang relatif besar, karena itu guru harus 

memiliki berbagai alternatif metode pembelajaran yang efektif dan 

menyenangkan agar effectiveness dan joyfulness tersebut terwujud. Mengapa 

di Kabupaten Sleman? Sebab di Kabupaten Sleman diasumsikan sebagai 

daerah yang pemanfaatan ICT-nya masih kurang namun fasilitas IT-nya sudah 

memadai. Di samping itu sebelumnya sudah ada kerjasama awal dengan 
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MGMP PKn Kabupaten Sleman sekaligus ada permintaan dari mereka kepada 

FIS, khususnya Prodi PKn, untuk menyelenggarakan PPM ini bagi mereka. 

Kerjasama awal ini tentu akan meningkatkan efektivitas penyelenggaraan 

PPM.  

 

B. Keterkaitan 

Program ini melibatkan beberapa pihak terkait di antaranya: 

1. Jurusan Pendidikan Kewarganegaran dan Hukum FISE Universitas Negeri 

Yogyakarta. Beberapa dosen terkait akan dilibatkan sebagai narasumber, 

trainer, atau instruktur dalam pelatihan ini. Keterlibatan Jurusan PKN dan 

Hukum UNY dalam kegiatan ini akan meningkatkan interaksi akademik 

antara perguruan tinggi dan sekolah-sekolah, sehingga transfer informasi 

secara timbal balik akan melahirkan kedekatan antar kedua lembaga. Di 

samping itu, sebagai sebuah LPTK, UNY memiliki tanggung jawab 

akademik untuk maintenansi kualitas para alumninya, bahkan setelah 

mereka terjun sebagai praktisi pendidikan di sekolah-sekolah. 

2. MGMP (Musyawarah Guru Mata Pelajaran) di setiap kabupaten dan kota 

se-Daerah Istimewa Yogyakarta akan dilibatkan dalam bentuk delegasi 

peserta dan pemantauan keaktifan para guru dalam pelatihan ini. Bagi 

MGMP, kegiatan ini akan sangat bermanfaat dalam mendekatkan MGMP 

dengan perguruan tinggi melalui interaksi akademik semacam ini. Di 

samping itu, keterlibatan guru-guru dalam Pelatihan ini akan 

meningkatkan dinamisasi dalam tubuh MGMP. 
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C. Metode Kegiatan 

Kegiatan dilaksanakan dalam bentuk skimming dan scanning konseptual, 

praktek, dan pendampingan. Skimming dan scanning konseptual digunakan 

untuk secara sekilas mengelaborasi prinsip-prinsip pemanfaatan ICT, e-

learning, dan Hot Potatoes. Praktek diterapkan pada pengembangan instrumen 

evaluasi berbasis Hot Potatoes secara langsung oleh peserta, sedangkan 

pendampingan dilakukan oleh instruktur dalam proses pengembangan 

instrumen evaluasi menggunakan oleh peserta pelatihan/guru. 

  

D. Rancangan Evaluasi 

Rancangan evaluasi dikenakan pada dua aspek; teknis penyelenggaraan 

program dan kemampuan peserta program. Evaluasi teknis penyelenggaraan 

program dilakukan secara rutin dalam setiap sesi melalui pemantauan internal 

oleh pelaksana program. Selain itu juga dilakukan evaluasi dua bulanan yang 

melibatkan masukan dari peserta. 

Untuk mengukur kemampuan peserta, evaluasi komprehensif dilaksanakan 

dalam kesatuan proses yang terdiri dari pre program test dan  post program 

test. Pre program test dilaksanakan untuk mengukur kemampuan awal peserta 

pelatihan. Sedangkan post program test dilakukan untuk mengevaluasi 

kemampuan peserta setelah mengikuti seluruh tahapan program. 
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BAB III 

PELAKSANAAN KEGIATAN PPM 

 

A. Hasil Pelaksanaan Kegiatan PPM 

1. Hasil Kuantitatif 

Secara kuantitatif, hasil pelaksanaan kegiatan ini dapat dilihat dari hal-

hal kasat mata selama atau setelah kegiatan, mulai dari peserta hingga materi 

kegiatan. Kegiatan PPM ini diikuti oleh 25 orang peserta atau sekitar 80% dari 

target 30 peserta. 25 orang peserta tersebut adalah guru dari berbagai daerah di 

Kabupaten Sleman DI Yogyakarta. 

Penyelenggaraan kegiatan ini dilaksanakan selama satu hari, dengan 

program in class, dilanjutkan program mandiri plus online. Program di kelas 

meliputi searching program aplikasi Hot Potatoes, Installment program, 

penyajian materi, dan praktek pengembangan instrumen evaluasi berbasis Hot 
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Potatoes.  Sedangkan kegiatan mandiri plus online meliputi praktek mandiri 

pengembangan instrumen evaluasi berbasis Hot Potatoes. 

 Dari sisi materi, program ini menghasilkan beberapa bahan yang relatif 

komprehensif, berupa slide power point praktis pengembangan instrumen 

evaluasi berbasis Hot Potatoes yang dapat digunakan untuk pengembangan 

lanjutan dan diseminasi dalam skala lebih luas. 

 

2. Hasil Kualitatif 

Secara kualitatif hasil pelatihan dapat dinilai dari pencapaian hasil-hasil 

yang tak mudah dilihat secara kasat mata. Antara lain pertambahan 

pengetahuan dan sikap positif mengenai TIK, khususnya pengembangan 

instrumen evaluasi berbasis Hot Potatoes. Meningkatnya pengetahuan dapat 

diabstraksi secara sederhana dari interaksi yang terjadi selama pelatihan 

berlangsung. 

Di sisi ketrampilan, pelatihan ini telah meningkatkan kemampuan para 

guru peserta PPM ini yang terbukti dari telah berhasil dikembangkannya Hot 

Potatoes bagi seluruh peserta, meskipun masih di tingkatan beginner.  

Sedangkan sikap positif atas TI, khususnya pengembangan instrumen 

evaluasi berbasis Hot Potatoes, dapat dicermati dari antusiasme para guru dan 

kegigihan yang mereka tampilkan selama proses pelatihan berlangsung. Dalam 

pengamatan Tim penyelenggara antusiasme peserta cukup baik. Partisipasi 

peserta dalam merespons materi juga bagus, misalnya dengan bertanya atau 

permintaan didampingi salah satu anggota tim jika mengalami kesulitan.  
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Di samping itu, ada permintaan dari peserta untuk dilaksanakannya 

Pelatihan Lebih Lanjut terkait dengan materi-materi yang lebih advanced 

terkait dengan e-learning dan materi-materi lain yang dibutuhkan oleh guru.  

 

B. Pembahasan Hasil Pelaksanaan Kegiatan PPM 

Dari deskripsi hasil kuantitatif pelatihan sebagaimana disebutkan di 

muka, dapat dianalisis bahwa tingkat partisipasi peserta cukup tinggi, 

meskipun sesungguhnya jumlah tersebut masih bisa didorong lebih banyak 

lagi. Namun secara teknis, jumlah yang belum 100 persen tersebut tidak 

problematik melihat pelatihan pengembangan instrumen evaluasi berbasis Hot 

Potatoes untuk guru-guru ini baru lah kegiatan awal dan ke depan masih bisa 

di-scale up lagi untuk kalangan yang lebih luas. 

Penyelenggaraan kegiatan selama satu hari juga bukanlah target yang 

sejak awal dipatok. Namun demikian penyelenggaraan “sependek” itu 

merupakan hasil yang lumayan bagus. Dalam keadaan dapat diupayakan 

pendanaan untuk program PPM yang cukup besar di masa-masa mendatang, 

PPM dengan bentuk dan tema pelatihan serupa kegiatan ini bisa dilanjutkan 

bagi para guru sekolah-sekolah untuk kalangan yang lebih luas.  

Bila dikaitkan dengan tujuan awal PPM ini, yaitu: 1) Meningkatkan 

kemampuan memanfaatkan internet untuk pembelajaran bagi guru-guru 

Pendidikan Kewarganegaraan SMP se-Kabupaten Sleman D.I. Yogyakarta, 2) 

Mengembangkan kemampuan memanfaatkan blog sebagai media e-learning 
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bagi guru-guru Pendidikan Kewarganegaraan SMP se-Kabupaten Sleman D.I. 

Yogyakarta, maka kegiatan ini sudah mencapai tujuan tersebut.  

Kemampuan memanfaatkan internet dapat dilihat dari keberhasilan 

seluruh peserta membuat akun e-mail baru untuk kepentingan-kepentingan 

resmi/formal, baik pembelajaran maupun kebutuhan para guru berkomunikasi 

secara online. Peningkatan pemahaman para guru tentang HAM dapat 

diidentifikasi secara nyata dalam proses melalui keberhasilan mereka menyerap 

materi dari narasumber atau fasilitator.  

Dalam aspek ketrampilan, terjadi peningkatan kualitas keterampilan 

para guru, karena para guru di-engagement melalui sebuah praktek langsung di 

laboratorium internet yang terkoneksi secara online.  

Hasil tambahan (additional result) dari pelatihan ini adalah 

terselenggaranya pembelajaran online secara sederhana, melalui praktek 

mandiri dari materi yang dibagikan kepada peserta secara online pula.  Hal itu 

juga memberikan pengalaman bagi para guru untuk memanfaatkan media 

email untuk media pengiriman evaluasi pasca pembelajaran. Dalam 

pembelajaran nyata di sekolah guru dapat memanfaatkan berbagai media 

online, seperti microbloging (twitter), social media (blog personal atau blog 

komunitas), serta media jejaring sosial semacam facebook, dan sejenisnya. 

Namun demikian juga harus diperhatikan bahwa pembelajaran dengan 

memanfaatkan media film dan media online membutuhkan fasilitas yang relatif 

mutakhir. Beberapa sekolah yang sebagian besar sudah dilengkapi dengan 

laboratorium komputer yang sebagian sudah connected/online, sudah lebih dari 
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cukup di sisi fasilitas untuk menerapkan atau melanjutkan pengembangan hasil 

dari PPM ini bagi para peserta di sekolah-sekolah masing-masing. Namun dari 

sisi perangkat untuk pembelajaran dengan online media dibutuhkan teknologi 

yang lebih canggih. Jika pembelajaran akan dilaksanakan secara realtime di 

sekolah, maka sekolah harus sudah dilengkapi dengan jaringan internet baik 

dengan wireless fidelity (WiFi), Local Access Network (LAN), maupun dengan 

internet modem.  

Barangkali persoalannya tidak banyak sekolah yang dilengkapi 

perangkat teknologi komunikasi dan informasi ini, kecuali sekolah-sekolah di 

perkotaan. Namun demikian, dalam situasi fasilitas online sekolah tidak 

memungkinkan, guru dapat memanfaatkan warung-warung internet swasta, 

dengan catatan perlu diantisipasi juga keamanannya bagi siswa dari sisi konten 

jaringan warnet tersebut serta dari sisi penataan blok-blok internet. 
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BAB IV 

PENUTUP 

 

A. Kesimpulan 

Dari pemaparan terdahulu dapat disimpulkan beberapa poin berikut ini: 

1. Pelaksanaan PPM telah mencapai tujuan untuk meningkatkan 

pemahaman guru mengenai manfaat dan pemanfaatan IT yang 

selama ini jarang bisa ditemui yaitu untuk pengembangan 

instrumen evaluasi berbasis aplikasi. 

2. Peningkatan keterampilan guru peserta pelatihan ini sudah terlihat 

dari keberhasilan mereka membuat akun weblog di wordpress.com 

yang dapa digunakan untuk e-learning mata pelajaran PKn yang 

mereka ampu di sekolah masing-masing. 
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3. Di samping itu, pelatihan juga memberikan pengalaman kepada 

guru peserta pelatihan untuk memanfaatkan online media dalam 

pembelajaran Pendidikan Kewarganegaraan, khususnya email dan 

media sosial. 

 

B. Saran  

Setelah mendalami lessons learned dari pelatihan ini, dapat diajukan 

beberapa saran berikut ini: 

1. Kepada Fakultas: Diperlukan pendanaan memadai untuk 

menyelenggarakan PPM yang lebih baik, secara reguler, dan untuk 

kalangan khalayak sasaran yang lebih luas. 

2. Kepada Tim PPM yang lain: Dalam pelatihan dengan khalayak 

sasaran para guru diperlukan sinergi yang lebih intensif dengan 

MGMP secara kelembagaan. 
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Lampiran I 

 

MATERI PELATIHAN 
 



1

TUTORIAL HOT POTATOES 

1. Untuk memulai Hot Potatoes, klik menu Start > Program > Hot Potatoes > Hot Potatoes
sehingga akan dimunculkan :

2. Untuk membuat Soal Pilihan Berganda, klik JBC sehingga akan muncul :

3. Untuk menyimpan hasil pekerjaan Anda, klik menu File > Save, atau klik icon kemudian 
ketikkan nama file Anda. Nama file ada baiknya sama dengan judul bundel soal Anda, untuk 
memudahkan pencarian file.

4. Apabila Anda akan menyimpan gambar pada stem atau pada option, simpan dulu pekerjaan Anda,
kemudian file gambarnya disimpan pada folder yang sama dengan folder tempat soal disimpan. 

Setelah itu, klik menu Insert > Picture > Picture from Local File atau klik icon  . Pilih 
gambar yang sudah Anda siapkan dan klik Open, kemudian klik OK

5. Apabila Anda akan membuat tabel pada pertanyaan Anda, klik menu Insert > HTML Table atau
gunakan Ctrl-T, sehingga akan muncul :

ketikkan jumlah baris pada kotak 
Rows, jumlah kolom pada kotak 
Columns, ketebalan garis batas pada 
kotak Border, jarak antara sisi sel 
dengan isi sel pada kotak Cellpadding 
dan jarak antara border dengan sel 
pada kotak Cellspacing, dan tebal 
tabel pada halaman diisikan pada kotak 
Table width dalam satuan persen.  

keluar

Melengkapi 
kalimat

Menjodoh-
kan

TTS 

Pilihan 
Berganda 

Menyusun 
kalimat 

Jawaban 
singkat 

Judul  
bundel soal

Pertanyaan 
atau stem

Nomor 
soal, klik 
panahnya 
untuk 
meng-ubah 
nomor soal

Ketikkan pilihan 
jawaban disini

Klik ini apabila C 
adalah jawaban 
yang benar 

Ketikkan feed 
back disini, 
Feedback adalah 
untuk 
memberitahukan 
mengapa 
jawaban tersebut 
benar atau salah 
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Setelah itu akan muncul teks : 
<table border="1" cellpadding="2" cellspacing="2" width="100%"> 
<tr> 
<td></td> 
<td></td> 
</tr> 
<tr> 
<td></td> 
<td></td> 
</tr> 
</table> 
Isikan tabel perbaris di antara tag <td> dan </td> 
Contoh : 
<table border="1" cellpadding="2" cellspacing="2" width="100%"> 
<tr> 
<td>Nama Negara</td> 
<td>Nama Ibukota</td> 
</tr> 
<tr> 
<td>Indonesia</td> 
<td>Jakarta</td> 
</tr> 
</table> 
menghasilkan tabel : 

Nama Negara Nama Ibukota 

Indonesia Jakarta 

6. Karakter subsrcipt seperti angka 2 pada H2O dapat digunakan dengan mengetikkan tag <sub>2</sub>
sehingga H2O ditulis menjadi H<sub>2</sub>O. Untuk mempermudah, gunakan kombinasi tombol 
Shift+Ctrl+Panah bawah. Sedangkan karakter superscript (misalnya pangkat 2) menggunakan tab 
<sup>2</sup> sehingga 3x2 ditulis menjadi 3x<sup>2</sup>. Untuk mempermudah, gunakan
kombinasi tombol Shift+Ctrl+Panah atas

7. Apabila soal selesai dibuat dan sudah disave, langkah berikutnya adalah membuatnya menjadi soal 

interaktif dengan menekan tombol F5 atau icon  apabila Anda ingin membuat dalam versi Internet 

Explorer 5 atau menekan tombol F6 atau icon  menggunakan Internet Explorer 6. 
8. Untuk membuat Soal Jawaban Singkat (Quiz), klik JQuiz sehingga akan dimunculkan :

9. Untuk penyimpanan file, dan lain-lain sama dengan pada JBC.
10. Untuk membuat Soal Menyusun Kalimat klik JMix sehingga akan muncul :

Judul bundel 
soal 

Pertanyaan 
diketik disini 

Jawaban 
dan alternatif 
jawaban 
diketik disini 
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11. Untuk membuat soal interaktifnya, JMix memberikan 2 jenis apakah akan menggunakan teknik klik 

(gunakan icon  atau ) atau menggunakan teknik drag and drop atau diseret ke tempat 

sebenarnya (gunakan icon  atau ).
12. Untuk membuat soal berbentuk TTS, klik JCross sehingga akan muncul :

13. Anda bisa menggunakan tombol  untuk membuat TTS secara otomatis, klik tombol tersebut 
sehingga akan dimunculkan :

Ketikkan potongan-
potongan 
kalimatnya disini 

Ketikkan  alternatif 
jawabannya disini 

Judul soal 

Susunlah 
huruf-huruf 
disini untuk 
pertanyaan 
mendatar 
ataupun 
menurun 

Ketikkan kata-
kata yang akan 
dibuat tts disini 
seperti pada 
contoh 

Klik ini untuk mulai 
membuat TTS 
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14. Apabila jumlah kotak yang tersedia dirasa kurang, klik menu Manage Grid > Change Grid Size
kemudian masukkan jumlah kotak yang Anda inginkan.

15. Apabila huruf sudah selesai dibuat, klik Add Clues untuk memberikan pertanyaannya yang akan 
memunculkan :

16. Save, kemudian export sebagai Internet Explorer (kayak biasa!)
17. Untuk Soal Menjodohkan, klik JMatch sehingga akan dimunculkan :

18. Seperti halnya pada JMix, pada JMatch Anda bisa juga membuat soal yang drag and drop.
19. Untuk Soal Melengkapi Kalimat Anda bisa menggunakan JCloze, just klik dan akan ditampilkan :

Ketikkan 
pertanyaannya 
disini sesuai dg 
kata yang disorot 
dan klik OK 

Ketikkan kata-kata atau 
kalimat yang akan 
dijodohkan di kedua 
kolom kiri dan kanan ini 
dengan urutan sesuai 
dengan jawaban yang 
benar. 

Cek ini, apabila Anda ingin 
memperlihatkan jawaban 
yang benar pada pertama 
kali soal dimunculkan. 

Anda dapat menambahkan 
1 kata atau kalimat yang 
tidak berpasangan sebagai 
pengecoh. 
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20. Setelah naskah lengkapnya Anda ketikkan, blok kata atau frase yang akan Anda jadikan pertanyaan, 
kemudian klik tombol Gap sehingga akan dimunculkan:

21. Lakukan pembuatan Gap pada kata atau frase lain, setelah itu save dan buat versi Internet-nya.
22. Apabila Anda ingin menghapus beberapa Gap tertentu, blok dulu Gap tersebut, kemudian klik Delete

Gap, apabila ingin menghapus semua Gap, klik Clear Gaps, Anda juga dapat menggunakan tombol 
AutoGap bila kata-kata yang akan Anda buat Gap terpisah dalam jarak yang sama. JCloze akan 
menanyakan berapa jumlah kata pemisahnya.Tombol Show Words digunakan untuk memperlihatkan
Windows di atas.

23. Pada setiap bentuk soal, kecuali bila Anda menggunakan versi Drag and Drop pada JMix dan JMatch, 
Anda dapat membuat teks atau wacana yang dapat digunakan untuk membimbing siswa mengerjakan 
soal. Wacana yang ditampilkan dapat diatur berapa lama kemunculannya. Untuk melakukannya, klik

icon  sehingga akan dimunculkan jendela: 

24. Tekan OK kalau sudah.
25. Soal yang Anda buat bisa saja terdiri dari beberapa bundel soal, Anda dapat mengatur, apabila siswa 

sudah selesai mengerjakan satu bundel, kemudian pindah ke bundel lainnya. Perpindahan ini masih 
dapat dilakukan meskipun soalnya dibuat berlainan jenis, misalnya selesai mengerjakan soal Pilihan 
Berganda, kemudian dilanjutkan dengan soal TTS misalnya. 
Sebelum Anda mengaturnya, pastikan Anda sudah mengatur, file mana yang akan menjadi daftar isi, 
file mana yang akan menjadi file pertama, kedua, ketiga, dst. File daftar isi berisi pembukaan dan link 
menuju ke file pertama, kedua, ketiga, dst. Setelah itu buka file pertama dan lakukan pengaturannya 
sebagai berikut:

Ini kata yang 
Anda blok tadi

Petunjuk untuk menjawab soal, Anda bisa 
saja tidak mengisi ini. Apabila Anda 
mengisinya, akan muncul tanda tanya pada 
soalnya nanti 

Alternatif jawaban yang 
bisa diberikan oleh siswa. 
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Untuk melakukan pengaturannya, klik icon . Pada jendela yang muncul klik tab Buttons sehingga 
akan dimunculkan jendela berikut: 

Pada kotak Navigation, klik sehingga diberi tanda cek Include Next Exercise button, kemudian 
klik Browse dan pilih file kedua yang akan dibuka bila tombol bertanda => diklik. Klik sehingga 
diberi tanda cek Include Go to Contents button kemudian klik Browse dan pilih file html yang 
berfungsi sebagai daftar isi. 
Lakukan hal yang sama pada setiap soal.  
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